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INTRODUCTION
This document is intended to provide general guidance on the use of the FREEVAL-NC planning
level freeway analysis software. The focus of the user guide is on how to conduct a planning level
freeway analysis, and interpret the results of the computational engine. Since the software is
developed as an extension of the FREEVAL computation engine of the Highway Capacity Manual,
a number of references will be made to the underlying methodology. Throughout this document,
we will refer to the HCM’s 6th edition: A Guide for Multimodal Mobility Analysis, simply as “HCM.”
This document assumes that the user is at least familiar with the basics of the HCM Freeways
Facilities methodology of the HCM. The core computational engine, FREEVAL-NC (FREeway
EVALuation) 2015e is a computerized tool designed to faithfully implement the operational
analysis computations for undersaturated and oversaturated directional freeway facilities.
FREEVAL-NC is a faithful implementation of HCM Chapters 10 and 11, which incorporate all of the
freeway segment procedures for basic freeway segments, weaving segments, and merge and
diverge segments, respectively. For more information on FREEVAL-NC, the reader is encouraged
to consult the FREEVAL-NC User Guide (2).

OVERVIEW
FREEVAL-NC is the North Carolina specific version of FREEVAL designed to provide a user-friendly
environment that implements a planning level approach for freeway work zone and reliability
analyses. In addition, FREEVAL-NC has access to the Entire North Carolina freeway’s segmentation
database. The software strives to provide the ability to quickly test impacts of different work zone
scenarios as well as quantify effects of congested periods over time and space with the capability
of extending to include whole year reliability analysis. The planning level analysis provides many
useful default values to ease data entry, as well as to give the option to enter daily AADT values
or hourly demand flows. The software has been developed as an extension of the FREEVAL
computational engine, and as such allows access to the entire operational level analysis
capabilities of the underlying FREEVAL-NC core engine if the user decides to pursue that route.
Both the WZ toolbox and the core computational engine were built in the Java™
programming language. The environment allows the user to analyze a freeway facility of up to
500 HCM segments (to be defined or pulled from the segmentation database) and for up to
ninety-six 15-min analysis intervals (24 h). The engine can generally handle any facility that falls
within these temporal and spatial constraints. However, it is highly recommended that the total
facility length not exceed 9–12 miles in length to ensure consistency between demand variability
over time and facility travel time. Further, the spatial and temporal boundaries for any analysis
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(i.e., first and last time intervals and first and last facility segments) should be uncongested and
should allow all queues to form and clear within the specified time-space domain to assure that
performance measures fully account for the predicted extent of congestion and delay. These
aspects are discussed in detail in HCM Chapter 10. In conformance with the HCM, all analyses are
carried out using US customary units.

JAVA™ REQUIREMENTS
Version 8 or newer of the Java™ SE Runtime Environment (JRE) is required to run FREEVAL-NC. Any
version of Java™ 8 will be sufficient, but it is generally preferable to have the most up-to-date
version whenever possible. If you are not sure which version your computer is running, there are a
number of ways to check if your installed version of Java™ is sufficient or up-to-date (see next
subsection). The most recent version of Java can be acquired by going to the Java SE home page
and selecting the JRE download:
http://www.oracle.com/technetwork/java/javase/downloads/index.html
As of the writing of this document, the most recent version of Java JRE 8 can be found at:
http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html

CHECKING YOUR JAVA VERSION
WINDOWS USERS
In order to check the version of the JRE installed on your computer, open the Control Panel
program and enter “java” in the search bar. This will allow you to open the Java Control Panel.
Once in this screen, under the “General” tab, click the “About” button and a dialog displaying
the version should appear (see Figure 1). If the search does not return any results, then, likely, your
computer does not have any version of the JRE installed. An alternative way of checking can be
done by opening a Command Prompt window and entering the command “java –version”. If this
command returns an error or the output does not say “java version 1.8.0_xx” (xx can be any
number), then you will need to install or update the JRE.
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Figure 1: Example “About Java” dialog showing the currently installed version

MAC OS OR LINUX USERS
To check the installed version of java on a Mac OS or Linux computer, open an instance of
“Terminal” using the Launchpad or by using the Spotlight search. Then enter the “java –version”
command in the windows. If this command returns an error or the output does not say “java
version 1.8.0_xx” (xx can be any number), then you will need to install or update the JRE.

INSTALLATION AND RUNNING
Once an up-to-date version of Java™ has been installed, FREEVAL-NC can now be run on the
computer. First, a copy of the FREEVAL-NC.zip archive should be downloaded to the desired
installation location. Next, the contents of the archive must be extracted (Note: Some computers
will extract the files automatically if the zip archive is double-clicked, but on many Windows
machines the extraction must be done explicitly).
To extract the contents of the folder, either right-click on the zip archive and select the
“Extract” option or if in the .zip archive folder, choose the Extract tab and select the “Extract All”
option. In either case, the user will be prompted with a few simple instructions about the desired
location or the extracted file. Once the files have been extracted, FREEVAL-NC is now ready to
be run by double-clicking on the FREEVAL.jar executable.
It should be noted that the Java 11 release of the FREEVAL-NC can only be excuted on
Windows operating system. In this case, no Java installation will be required as all necessary
packages are embedded in the zip file.
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DOCUMENT ORGANIZATION
The next section gives a brief description of the structure and organization of FREEVAL-NC and
details on how to create a project. The document then presents a step-by-step description of the
process for creating a facility, model work zones, and conducting the comparison analysis along
with the reliability analysis. Finally, a number of appendices are included at the end of the
document to provide a further quick reference for the user.

CREATE FACILITY
The general layout of the main window of the program is shown in Figure 2. A menu bar of options
is shown at the top, and the Project Toolbox is found just below it. The left pane is divided into two
sections. The top section holds the Project Navigator, where projects are displayed in a
collapsible/expandable tree format. The bottom presents a message log for the program, where
a log of the actions by the user is recorded, and some errors may be displayed when they occur.
The largest central area of the window is the input/output module and a map view, which consists
of a tabbed pane where the user can toggle between the single seed or scenario inputs and
outputs tables/map, a compare panel, and various output summaries. As shown in Figure 2, the
Single Seed/Scenario I/O panel contains a facility preview graphic and the analysis period input
and output table.
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Figure 2: General layout of FREEVAL-NC.

After opening the program, the user can choose to create a new seed file from scratch, open an
existing seed file, or import an existing facility through the use of the ASCII file format. This step will
address the creation of a new facility. To create a new facility, the user opens the Project menu
and selects the New Project option. Then a window will pop up (Figure 3) and provides the user
with three options to create the facility. Next, the three different methods of facility creation is
discussed.
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Figure 3: Creating a new facility from scratch and options available in FREEVAL-NC

EXTRACT FROM SEGMENTATION DATABASE
By selecting the “Segmentation Database” option in “Create New Project” window (Figure 3),
FREEVAL-NC will utilize the online segmentation database to create the facility. The online
segmentation database contains all interstate and non-interstate freeways in North Carolina. After
selecting the segmentation database, FREEVAL-NC will open the online segmentation wizard. In
this wizard, the user can choose the stretch of freeway to be imported and opened by FREEVALNC by clicking on the “Submit Button”, as shown in Figure 4.
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Figure 4: Online segmentation database wizard in FREEVAL-NC

By importing the geometry and demand information from the online segmentation database, then
FREEVAL-NC will invoke the user to the next steps in gathering other necessary details to create a
facility. The next step is to provide FREEVAL-NC with temporal limits of the analysis as well as several
prefill parameters that are defaulted to HCM or NC specific values. Figure 5 shows the “Global
Input” window in FREEVAL-NC.
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Figure 5: Global Input dialog for FREEVAL-NC.

The last piece of information that needs to be determined is the hourly demand profile that will be
utilized to calculate the hourly demand flow rates for all on-ramps and off-ramps as well as the
freeway mainline for all 15 minutes analysis periods. There are three options available in this step,
which are “Bimodal-AM”, “Bimodal-PM”, and “Unimodal” as shown in Figure 6. Generally, if the
analysis is for a freeway that is going or coming into a large metropolitan area on a weekday, then
Bimodal-AM and Bimodal-PM need to be selected respectively. Otherwise, the unimodal
distribution should be chosen. This window contains a few local profiles extracted from permanent
and temporary count stations. It is recommended that the user check “Facility Specific” profiles
and picks local profile if it is available on the selected stretch of freeway facility.
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Figure 6: Hourly demand distribution determination

By clicking “OK” in the “Demand Profile Selection” window, FREEVAL-NC will import data and
create the facility. The user can select the “Show map view” from the “View” menu to enable map
view while staying in the “single scenario/seed I/O” tab (Figure 2).

AUTOMATIC SEGMENTATION USING MAPPING TOOLS
The first segmentation step in map-based option will consist of two primary processes. First, an initial
HCM compliant segmentation will be created using FREEVAL’s existing autosegementation
feature. However, this algorithm is not fully comprehensive, and so a second manual check and
adjustment process will be conducted. This will make use of an enhanced map interface, allowing
segments to be edited using drag/drop, merge, delete, and length specification features.
First, the user should select “Map-based Segmentation” from “New Project Wizard” (Figure 3). This
feature allows for a facility to be created based on a set of user-specified gore points and capacity
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changes. Each gore or capacity change point is entered via a Google Maps interface and
requires the user to specify a small number of inputs including section name, number of lanes,
speed limit, number of ramp lanes, and ramp side. Additional values such as section length are
automatically computed using the Google Maps routing API.
The user interface consists of a large map area, as well as a table that is populated as points are
added to the map. For each specified stretch of the freeway being segmented, the user will click
on the map to drop a marker at each ramp gore or capacity change point. A freeway’s capacity
is considered to change when the number of through lanes changes, or there is a change in speed
limit. Each point will be represented as a “node” in the table (with Node 0 indicating the facility
start). Once at least two points have been placed along a route, “sections” will be drawn between
adjacent points, and a corresponding column will be added to the table, labeled as “Section n”
where n denotes the section number (starting from 1). As a note, the number of nodes will always
be one more than the number of sections. The screenshot in Figure 7 shows what the map and
node/section table would look like for a simple interchange. Note that Section 2 has been selected
in the upper table, which causes it to be highlighted on the map.

Figure 7 Example of how the ‘facility create’ is populated with nodes and sections.
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The user should populate all node and section inputs as they create the facility. The section length
is automatically determined using routed distances, and the number of mainline/through lanes
and speed limit should be specified for each section (one way the number of lanes can be
determined is using the satellite view accessed via the controls at the top of the map). The input
required for each node depends on the node/gore type indicated using the dropdown selection
in the first row of the table. The facility start and end nodes, as well as lane change nodes, do not
require any additional inputs. Ramp nodes allow the user to specify the following values:
•
•
•
•

Number of Ramp Lanes
Ramp Side
Exit Number
Exit Name

Finally, once all ramp gores and capacity changes have been marked, a “facility end” node
should be placed to indicate the downstream end of the supersection’s scope. The current set of
nodes and sections should be saved using the “Save Sections” button at the bottom of the map
interface.
Before moving on to seed creation and the manual check and adjustment step, there are several
interface features available to help expedite and facilitate the above process:
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Table 1: Map features of FREEVAL-NC

Interface Feature
ENABLE/DISABLE PIN DROP

MARKER DRAG/DROP
MERGE SEGMENTS
SPLIT SEGMENTS
RIGHT-CLICK MENU
SATELLITE VIEW

UNDO LAST MARKER

SAVE SECTIONS

LOAD SECTIONS
ZOOM

Feature Description
Enables or disables the “click to drop pin” functionality. Useful when not
actively adding to a facility, for example when panning or zooming in
satellite view.
The location of any marker can be adjusted by dragging it to a new
location. The routing to any upstream or downstream markers will
automatically update.
Double-clicking a marker merges two adjacent sections into a single
section.
Double-clicking a section’s polyline splits the section in half and adds a
new node in the center.
Right-clicking when placing a marker brings up a list from which the user
can select the node type.
At any point, the map can be switched to satellite view to further inspect
the geometry of the facility. Particularly useful to determine the number of
through or ramp lanes, as well as lane changes.
This button will remove the marker at the downstream end of the facility.
This is useful to undo any markers placed by errant clicks on the map.
However, it does not truly “undo” the previous action, as in the case of a
segment merge or split.
At any point during the process, the list of nodes and sections can be
saved to a “sections” file (.sec). This allows for backups to be created
along the way as the maps interface might occasionally crash, especially
in the case of poor internet connection or speed.
Any sections file (.sec) can be loaded back into the interface to resume
the facility creation process, or modify an existing set of sections (e.g., in
the case of a missed ramp or lane change).
There are two zoom buttons, one that zooms to the node or section
selected in the upper table, and one that zooms to the facility extent.

Next, with the nodes and sections for the supersection defined, the FREEVAL-NC seed file can now
be created. Pressing the “Create Seed” button launches the autosegmentation algorithm, which
translates the nodes and segments to HCM compliant segments and creates a facility seed file.
Depending on the complexity of the facility, it is possible that a warning popup will appear
indicating that the autosegmentation algorithm found a situation outside of the limitation of its
segmentation logic. For now, the “leave as is” option should be chosen for each issue, which can
be manually accounted for in the following steps. An example of a warning window is shown in
Figure 8. At this point, the initial segmentation process is complete.
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Figure 8 Example of a warning thrown by the autosegmentation process where it encountered an extremely short
segment.

The new seed file created in the previous step is now made up of (mostly) HCM compliant
segments. However, in the autosegementation process, the connection between the segments
and the underlying Google Maps routed polylines was broken. Using the top menubar, select View>Show Map View to open the Facility Map Viewer in FREEVAL’s Single Seed/Scenario I/O tab. The
map should then load and display markers for all segment boundaries, but with just simple straightline polylines between each adjacent set of points. In this case, the viewer will automatically iterate
through every segment, routing each distance to create true polylines. Note that depending on
the number of segments in the facility this may take a few minutes. While this process is running, the
bar at the bottom of the map will read “Routing Seg. n” and will read “Map Ready” when the
process is complete.
Once the polylines have been routed save the seed file as this will now save the routed polylines
so the routing process will not have to be redone. From this point on, whenever the seed is opened
in FREEVAL-NC and the Map View is enabled, the pre-routed polylines will automatically load.
A manual inspection of the facility should now be conducted. In most cases, the
autosegmentation algorithm must project at least a few segment boundaries along the routed
polylines. Due to rounding errors, the projected coordinates may no longer exactly fall where they
should on the freeway, causing strange routing behavior. This is demonstrated in Figure 9 where a
point was slightly shifted, causing Google to think it was on the ramp as opposed to the mainline.
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Figure 9 Example of a case where the coordinates of appoint were slightly shifted and incorrect routing behavior
occurred.

This type of behavior can be easily corrected through a drag and drop adjustment. By default, the
map view interface does not allow for marker adjustment, and so it must be enabled by selecting
View->Map Options->Enable Map Point Adjust from FREEVAL’s menubar. When Map Point Adjust is
enabled, the color coding of the segments will change from being output (LOS) based to being
reflective of segment type: blue is a basic segment, green is an off-ramp segment, red is an onramp segment, and purple is a weaving segment. Figure 10 shows an example of how an incorrect
routing can be corrected using the interface drag/drop point adjust feature. Once all incorrectly
routed segments have been adjusted, the file should once again be saved.
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Figure 10 Demonstration of the drag/drop point adjust feature to fix incorrect segment routing.

18

July 2019

FREEVAL-NC
User Guide

July 2019

Next, the segmentation now needs to be manually inspected to ensure correctness and adjusted
in the case of any identified issues. While the autosegmentation algorithm should handle most
facilities, there are occasions where it may fail. This could be due to overly complex or unexpected
configurations that fall outside of its coded logic. When this occurs, it will likely result in an incorrect
segmentation, and so the supersection should be manually inspected to identify any issues. When
problems are found, the appropriate steps should be taken to address them. The following table
highlights some of the potential errors that would need to be fixed:
•
•
•
•

Missed segment boundary due to lack of data (e.g. missed lane add/drop or speed limit
change)
Missed segment boundary due to algorithm fail (e.g. a set of closely spaced ramps )
Incorrect segment type assigned
Incorrect segment length assigned

Just as in step 3, almost all of the issues encounter can addressed using the Google Maps interface
by enabling the “Map Point Adjust” option. Many of the features available during the initial
segmentation of Step 1 are now available again. This includes adjusting segments boundaries by
dragging markers, splitting and merging existing segments, and manually setting segment lengths
in the Single Seed/Scen I/O table. The following table further describes this set of features.
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Table 2: Google maps view options to adjust and correct segmentation

Interface Feature

Feature Description

MARKER DRAG/DROP

The location of any marker can be adjusted by dragging it to a new
location. The routing to any upstream or downstream markers will
automatically update, as well as the respective segment lengths.
Double-clicking a marker merges two adjacent segments into a single
segment. The segment type will be assigned as that of the former upstream
segment, and the new segment length will be automatically computed.
Double-clicking a segment’s polyline splits the segment even into two
segments. The new segment will be a basic segment, and the lengths of
both segments will be automatically updated.
At any point, the map can be switched to satellite view to further inspect
the geometry of the facility. Particularly useful to determine the number of
through or ramp lanes, as well as lane changes.
Clicking on the map will place a new marker and add a segment to the
downstream end of the facility. The new segment will be a basic segment
and its length with be automatically computed via Google’s routing API.
This button will remove the marker at the downstream end of the facility
and delete the end segment. This is useful to undo any markers placed by
errant clicks on the map. However, it does not truly “undo” the previous
action, as in the case of a segment merge or split.
When helpful, the user can use the Single Seed/Scen IO table to manually
specify the length of a particular segment. Note that the length will always
be taken or given to the downstream segment EXCEPT in the case that the
segment is an off-ramp/diverge, in which case any change in length will be
reflected in an adjustment of the length of the upstream segment (in order
to best account for the diverge influence area being upstream of the ramp
gore).

MERGE SEGMENTS

SPLIT SEGMENTS

SATELLITE VIEW

mAP CLICK

UNDO LAST MARKER

MANUAL LENGTH ENTRY
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MANUAL SEGMENTATION
After selecting the “Blank Template” option in the new project wizard (Figure 3), the global input
dialog will appear (Figure 11). Here, the user selects the study period to be analyzed and specifies
the number of segments in the facility (note: the user can revise these at a later time in the analysis
if necessary). Other settings include whether the facility free-flow speed is known or should be
calculated, whether ramp metering is used, the type of terrain, and the jam density of the facility
(used for oversaturated calculations). For a full explanation of all of the Global Input parameters,
please refer to the HCM. After completing all global settings, select “OK” and FREEVAL-NC will then
generate a new facility seed file. Depending on the computer used, this process may take a
minute.

Figure 11: Global Input dialog for FREEVAL-NC.
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SINGLE STUDY PERIOD ANALYSIS
This section provides guidance on how a single study period analysis is done in FREEVAL-NC. Details
on open/save, edit facility geometry and demand, along with a number of data entry wizards will
be discussed.

SAVING AND OPENING FILES
FREEVAL-NC deals primarily with two types of file formats: (1) a binary format with the “.seed” file
extension and (2) a plain text ASCII format that can be used to create version-independent
backups of facilities.

Saving and OPENING Files in the SEED format
FREEVAL-NC can save and open files in the .seed format. To save a file, open the Project menu in
the menu bar and select either “Save Project” or “Save Project As.” “Save Project As” allows the
user to create a new file with a specified name. If the active project already exists in the “.seed”
file format, “Save Project” will write any unsaved changes to the file. If the project has not yet been
saved as a “.seed” file, “Save Project” will provide the same functionality as the “Save Project As”
option. The top bar of the program window will indicate whether or not the project has been saved
as a “.seed” file, and if so, it will display the file name.
To open a “.seed” file, select the “Open Project” option in the Project menu and use the file
explorer to select the appropriate file location.
IMPORTING AND EXPORTING ASCII FILES
The ASCII file format provides a plain text version of the facility that can be created or edited in
almost any text editor. The format consists of headers and associated values for each segment in
each time period of the study period. The ASCII file contains all parameters that are included in
the core analysis methodology. FREEVAL-NC can export any facility to an ASCII format file. This is
important because each ASCII version of a facility serves as a FREEVAL-NC version independent
backup of a facility. In other words, an analyst can transfer an existing facility analyzed in an older
version of FREEVAL-NC into a newer release by using the ASCII import and export utility.
A facility can be exported to ASCII file format by selecting the “Export to ASCII” option from the
Project menu and specifying a filename and location. The file will be saved as a text file (.txt) file
extension), which can also be viewed or edited in standard text editors like Notepad, although this
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is only recommended for advanced users as the import is very sensitive to formatting of the text
file.
Any ASCII file conforming to the specified facility format can be imported into FREEVAL-NC using
the “Import from ASCII” option in the Project menu. Once imported into the program, it is
recommended that the project be saved as a “.seed” file for all subsequent analysis.

EDITING A FACILITY

DATA ENTRY IN THE SEGMENT I/O TABLE
Most inputs regarding individual segment geometry and volumes appear in the individual timeperiod segment input/output (I/O) table. Some variables are pre-coded with default values, but
all can be readily overridden by user input.
In the I/O table, a green row name indicates that the input parameter is time-independent (e.g.
segment type and segment length), and a yellow row name indicates that the parameter can
vary for each analysis period (e.g. mainline and ramp demands). The user must enter the demand
flows for each mainline segment and for each ramp in every time interval. These cells are
highlighted in yellow in the engine to assist with data entry. If a parameter is not applicable to a
given segment, then the table cell will not be editable and will have a dark gray background. In
FREEVAL-NC, demand volumes are protected to not be edited by the user to retain information
needed for PDF reports. Any demand change should be done by “Edit Demand” wizard, discussed
later this user guide.
The rows of the segment input table are generally grouped by the segment type for which they
are applicable. Parameters pertaining to all segment types are found at the top of the table,
followed by basic segment parameters, on-ramp segment parameters, off-ramp segment
parameters, and finally weave segment parameters (see Figure 12).
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Figure 12: Segment I/O Table.

CODING SEGMENT TYPES
Once the facility has been created using manual data entry, the user should first enter the type of
each segment (Figure 13). The proper way to define the appropriate number of segments is
explained in HCM Chapter 10, which includes the requirement that the first and last segments of
the facility should be coded as basic segments. Using drop-down menus, the user defines each
segment as a basic, on-ramp, off-ramp, weaving, or overlapping ramp segment following HCM
conventions (see Chapter 10). If other methods of facility creation are employed, then there are
not need to reenter these data as they will come from either the segmentation database or the
mapping tools.
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Figure 13: Selecting the segment type from the drop down menu.

SEGMENT DATA ENTRY
The common inputs needed for all segments are: length (ft), number of lanes, free-flow speed
(mi/h), segment demand (veh/h), % Single Unit Trucks and Buses, and % Tractor Trailers.
Additionally, the user can utilize several adjustment factors that may affect the operations of the
facility.
For all ramp and weaving segments, the user further needs to enter the ramp demand flows and
can adjust the heavy vehicle percentages as desired. Note that a time interval corresponds to a
15-min analysis period, and as a result all volume inputs should take the form of 15-min demand
flow rates (in vehicles per hour). No PHF adjustment is necessary. Ramp segments further require
the user to enter the length of the acceleration or deceleration lane, and the ramp free-flow
speed. Weaving segments require specification of the weaving segment geometry, following
guidance in HCM Chapter 13: Freeway Weaving Segment.
TRAVERSING BETWEEN TIME PERIODS
After entering all input for one time period, the Analysis Period (AP) control buttons can be used to
move to the next time interval (see Figure 14). The control panel allows the user to move forward
or backward in steps of one period (arrow buttons), to move directly to the first or last period, or to
“jump” to a specific period. The “active time period” is the period for which inputs are currently
displayed, and for which level of service (LOS) outputs give the facility preview graphic its color
coding. The active time period is given immediately to the left of the AP control buttons, specifying
both its index in the numerical order of periods and the 15 minute interval to which it corresponds.
Demand volumes will always need to be entered for all time intervals, but if any parameters are
constant for some or all time periods (or segments), it is recommended to use the “Fill Data” tool
as discussed in the next section. After completing all inputs for all time intervals and checking for
correctness, the user can move on to viewing outputs and evaluating the performance of the
facility.
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Figure 14: Analysis Period control buttons.

CHANGING THE SEGMENT I/O TABLE SETTINGS
The Segment I/O table is implemented to be highly customizable. For the table as a whole, the user
can specify both the font type and the font size. For each row that appears in the table, the user
can specify custom row names and set the row name background. Further, the user can also
specify in which version of the table (i.e. input, output, or both) each row appears.
To modify the Segment I/O table settings, the user can right-click on the table and select the “Table
Settings” option from the popup menu, opening the “Table Settings” dialog. All changes to the
table settings can be set as the default settings for future use by using the “Save as Default” button,
and the settings can be reverted to the original program defaults by using the “Reset all” button.
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Figure 15: Table Settings Dialog.

EDIT DEMAND WIZARD
FREEVAL-NC utilizes an enhanced mechanism that is called “Demand Wizard”, to make changes
to the demand. This feature is the only place that allows any changes and as such, the backend
information on how the demand is calculated is preserved (e.g., AADT). The backend information
often times are desired to be included in the reports. If the “segmentation database” is selected
as a means to create analysis, then the demands are already be prefilled via information coming
from the online database. Otherwise, a “low” and “constant” number will be used to prefill the
demand which will need to be updated by the user. In either case, editing the demand is a vital
piece of any simulation software.
In order to access, the “demand wizard”, the user must click on the “Edit Demand” button on the
top-left side of the screen.
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Figure 16: Demand wizard in FREEVAL-NC

In order to edit the demand, first, the user must select the subject segment on the top-left side of
the screen. Note that for the segments that no demand entries are associates, there will not be
any inputs on this screen. Figure 16 shows the demand wizard with segment #1 is selected. As seen,
the middle of the screen (frame #2), provides input controls to alter the demand. The information
needed is AADTs and Directional Distribution factor. On the right side of the window, the user can
select an hourly demand factor that should apply to the AADTs. Once, the users are comfortable
with the change, then by pressing “Apply Demand Changes”, he/she can enter the new demand.
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Figure 17: Interim demand evaluation in the demand wizard.

The demand wizard provides an interim mean to evaluate the demand that is entered. Of course,
this interim evaluation is only designed to give some intuition on how demand stands with respect
to the capacity considering upstream demand that is coming to the selected segment. As shown
in Figure 17, there are two graphs on the bottom of the screen that present demand on segment
#16 which is an on-ramp along with overall demand and capacity on this segment.
When the user is comfortable with the changes, he/she can press “Save Changes and Return” on
the top-right side of the screen which will save the changes and take the user back to the FREEVALNC’s main window. Otherwise, the user can select “Discard Changes and Return” to withdraw the
changes made in this wizard.

FILL DATA FEATURE

A “Fill Data” tool has been implemented in the engine to help expedite the data entry process.
Whenever an input parameter is the same for multiple segments and/or time periods, the tool can
fill the value automatically. Figure 18 shows the “Fill Data” dialog. The user first selects which input
parameter is being filled and then enters the desired value. The user can either choose to fill the
value for all applicable segments or can choose to select a subset of segments. This can be done
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by holding down the “Shift” key to select a contiguous group or by holding down the “Ctrl” key to
select any number of segments independently.
If the input parameter is also time dependent, the analysis periods for which the value is filled can
also be specified in the same way. Once the value and segments/time periods have been
specified, the user must click the “Fill Data” button. The data will be filled and a confirmation
message will appear in the log of the main FREEVAL-NC window. It is important to note that the
dialog will remain open after the “Fill Data” button has been pressed. This allows the user to fill
values for multiple input parameters without having to reopen the dialog. Once the user is finished,
the “Close” button will close the window and return to the main input window.

Figure 18: Fill Data Wizard.
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ADD/DELETE SEGMENTS AND TIME PERIODS
Both the number of segments and times can be changed at any point when editing or evaluating
a facility. However, since doing so will change the core facility, this process will automatically
remove any reliability or ATDM analysis currently included in the project. This process is irreversible,
so the user should be sure to save a version of the project if they wish to maintain any existing
reliability or ATDM analysis. To add or delete segments in the facility, use the “Edit” option in the
menu bar at the top of the program and select the appropriate option. This change will break the
map visualization and a warning message will be displayed (Figure 19).

Figure 19: Map Viewer Conflict in FREEVAL-NC on adding/removing segments

Once the correct option has been selected, a dialog will appear prompting the user for the
relevant information (see Figure 20). When adding a segment, the User must specify the position of
the segment(s) by indicating which segment it (they) will be added before. The user also specifies
the number of segments that will be added. To delete a segment (or multiple segments), the user
will specify the range (inclusive) of segments that will be deleted. To delete a single segment, the
first and last segment of the range should be the same.
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Figure 20: Dialogs for adding or deleting segments and time periods.

In the “Add Period” dialog, the user must specify the number of periods that will be added, and
whether or not they will be added to the beginning or end of the current study period. For example,
if the current study period is from 4:00pm-6:00pm, adding 4 periods at the end will increase the
number of analysis periods from 8 to 12 and change the study period from 4:00pm-7:00pm. Similarly,
when deleting time periods, the user specifies the number of periods to be deleted and whether
they will be deleted from the beginning or end of the current study period.
In order to add/remove segments in a way to not conflict with the map view functionality, the user
must perform this action in the map view. For this purpose, the user need to click on the “Toggle
Segment Editing Mode” in the map options located on the top-left side of the map view (Figure
21). Then, by double clicking on any segment, that segment will be split into two segments
(segment add), and by double clicking on the red balloons, the node will be deleted and the two
sequential segments will be merged together (segment delete).

Figure 21: Toggle edit mode in FREEVAL-NC to add or delete segments.
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TRAFFIC RESPONSIVE RAMP METERING
FREEVAL-NC is capable of performing adaptive or traffic responsive ramp metering. Three ramp
metering algorithms are incorporated in FREEVAL-NC, that are MaxView, Fuzzy, and ALINEA. In
order to use any of these algorithms in the analysis, first their parameters need to be configured to
reflect the conditions on the subject facility as well as the area. By clicking on the adaptive ramp
metering option in the Edit menu, the user can invoke “Edit Adaptive Ramp Metering Parameters”
window (Figure 22). In this window, the user can create schemes for any available adaptive ramp
metering algorithms, and edit the parameters. Once, this task is performed, then the user can apply
the ramp metering from single scenario IO view as well as “Fill Data” dialogue.

Figure 22: Traffic responsive ramp metering configuration for FREEVAL-NC.

MaxView Ramp Metering Algorithm: This is the default ramp metering algorithm in North Carolina.
This algorithm uses a look up table to meter the ramps. In order to meter the ramp at a certain level
(indicated by “Metering Rate for Lx” in Figure 22), the volume, occupancy, or speed needs to
trigger that level. As seen in Figure 22, this algorithm is consisted of six different levels indicated by
“L”.
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EVALUATING A FACILITY

OUTPUTS
FREEVAL-NC tool continuously computes the segment and period outputs and facility
performance measures automatically as inputs are entered, so there is no need to ask the program
to perform an analysis run for a seed facility. Further, the outputs and performance measures can
be viewed at any point during the creation or editing of a facility, though results from a facility with
incomplete inputs may be misleading.
The outputs for a given project can be found in three different places in FREEVAL-NC: the facility
preview graphic, the segment I/O table, and a set of summary data panels.
OUTPUT IN THE FACILITY PREVIEW GRAPHIC
The facility preview graphic provides the simplest set of outputs in FREEVAL-NC. In the graphic each
segment is colored according to its Level of Service (LOS) for the active time period. The colors
range from green (LOS A) to red (LOS F). Scrolling through the study period with the analysis period
controls can give a brief look at how congestion evolves over time on the facility.
OUTPUTS IN THE SEGMENT I/O TABLE
For a more detailed look at the performance of the facility, the user can view individual segment
and period outputs and performance measures for a facility in the segment I/O table. The segment
I/O table has the ability to display the facility inputs and outputs for the active time period,
respectively, or both at the same time. A drop down menu in the top left corner of the “Single
Seed/Scenario I/O” panel allows the user to choose between these three options: “Input,”
“Output,” and “In & Out” (see Figure 23).
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Figure 23: Selecting to display output in the Segment Table.

When the output option is selected, the table will display the segment outputs and performance
measures for the active time period (Figure 24). The configuration of this table can be customized
similar to what was discussed for inputs in Section 2.3.1.4. For a complete discussion on the meaning
and computation of these outputs, please refer to Chapter 10 of the HCM.

35

FREEVAL-NC
User Guide

July 2019

Figure 24: Individual segment outputs and performance measures for the active time period displayed in the segment I/O
table.

OUTPUT IN THE MAP VIEW
The mapping tools provides another simple set of outputs in FREEVAL-NC. In the map, each
segment is colored according to its Level of Service (LOS) for the active time period. The colors
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range from green (LOS A) to red (LOS F). Scrolling through the study period with the analysis period
controls can give a brief look at how congestion evolves over time on the facility.
OUTPUTS IN THE CONTOUR AND SUMMARY PANELS
The fourth way to view output is through a set of panels containing contour plots and summary
tables. The contours show how a select number of performance measures vary by segment and
time interval. The available performance measures include volume-to-capacity ratio (v/c),
demand-to-capacity ratio (d/c), segment speed, segment density, influence area density, and
queue percentage. To change the available performance measures, use the toggle buttons at
the bottom of the panel. An example contour table is shown in Figure 25.

Figure 25: Example of a D/C contour plot.

For facilities with a large number of segments or when analyzing facilities over long study periods,
the contour tables can become too large to view effectively on most screens. To help alleviate
this issue, a zoom function has been included in the engine. To zoom out (make rows and columns
smaller), the user should hold the “Ctrl” key and scroll up using their mouse’s scroll wheel. To zoom
back in, the user simply needs to hold the “Ctrl” key and scroll down using the mouse’s scroll wheel.
Alternatively, the user can zoom in or out by pressing “alt-shift-plus” (+) or “alt-shift-minus” (-).
However, if this method is used, the user must first click on a cell inside the table to enable this
functionality. All tables in the summary contour tab can further be copied and pasted into a postprocessing tool like Microsoft Excel.
In addition to the numerical performance measure contours, FREEVAL-NC also provides contours
for level of service (LOS). Consistent with the discussion in Chapter 10, FREEVAL-NC provides two
LOS contour tables. The upper table in Figure 26 gives the density-based levels of service criteria,
while the bottom table gives supplemental LOS information for any segments where demand
exceeds capacity. For demand based LOS, all cells with LOS E or better are shown in green, while
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cells with LOS F are colored red. Notice that the LOS reported by the two tables may not necessarily
be the same.

Figure 26: LOS Contour Tables for an Example Oversaturated Facility. This facility is undersaturated for all time periods, so
the demand based LOS is entirely green. For an example of the contour for an oversaturated facility see Section 0 and
Figure 34.

Beyond the contour table panel, there are two summary panels. The first summary panel, labeled
“Analysis Period Summary,” contains aggregated outputs and performance measures for each 15minute time interval. The aggregated results come in the form of summations, averages or extreme
values (i.e. maximums) over all segments in the analysis period. For example, the table provides
average speed and travel time over all segments, but gives the maximum demand-to-capacity
ratio (d/c) across all segments in each 15 minute time interval. For more information, the
aggregation of performance measures is consistent with the computations presented in Chapters
10 and 25.
The Analysis Period Summary panel consists of a single table in which each column represents a
time period and each row displays a different output or performance measure. The header of
each column gives the time at the start of the corresponding analysis period and the numerical
index of the period in the study period. For example, in a study period from 17:00 – 18:15 (5 APs),
the header of the column corresponding to the first analysis period from 17:00-17:15 would read
“17:00 (1).” The outputs and performance measures are aggregated across all segments in the
facility and include actual travel time, mainline delay, density, and travel time index (TTI) among
others. The “Analysis Period Summary” of an example facility is given in Figure 27.
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Figure 27: Example Analysis Period Summary.

The Segment & Facility Summary panel (Figure 28) contains time-aggregated results for each
segment in the facility. Again, the aggregated results are general in the form of averages or
extreme values (i.e. maximums) over the study period. Provided all segments operate below
capacity (at or below a d/c ratio of 1.00) in all time intervals, all individual segment results are
obtained by Chapter 12–14 methodologies. The final column provides a summary of each output
or performance measure for the facility as a whole. The measures of the first eight rows are
summarized by a summation across the facility, while the final four rows are summarized by
providing the average value across the facility.
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Figure 28: Example Segment & Facility Summary.

COPY AND PASTING DATA INTO OTHER SOTFWARE PROGRAMS
Most of the tables in FREEVAL-NC can be copied to the system clipboard and then pasted into
other programs such as Microsoft Excel or Microsoft Word. To do this, simply right click on the desired
table and select the “Copy Table to Clipboard” option.

CALIBRATION AND REVISING INPUT DATA
Once all the facility inputs have been entered and a preliminary evaluation of the outputs has
been performed, it is expected that analysts will need to use the methodology to further calibrate
the facility, to test various scenarios, or to perform sensitivity analyses. The FREEVAL-NC
computational engine has been designed to easily allow the user to revise input data and make
changes to geometry, demand, and other input variables to test the effect of such changes on
the operations of the facility. Motivations to revise inputs include:
•
•
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Testing geometric changes such as added lanes, different ramp configurations, or
alternate weaving patterns in select segments; and
Testing the operational effects of work zones and/or incidents through changes in
segment capacity and/or free-flow speeds.

FREEVAL-NC provides four types of adjustment factors that are intended to assist the user in
performing facility calibration and basic sensitivity analyses. These are the following:
•
•
•
•

Origin/Destination Demand Adjustment Factors;
Capacity Adjustment Factors;
Free Flow Speed (FFS) Adjustment Factors; and
Driver Population Adjustment Factors.

The adjustment factors are described in more detail below.
ORIGIN/DESTINATION DEMAND ADJUSTMENT FACTORS
The origin and destination demand adjustment factors are used to test the effect of an increase
or decrease in the original demand volumes by a user-defined growth or shrinkage factor. Each
segment contains one origin and one destination adjustment factor for each time interval, both of
which act as simple multiplicative factors that adjust the entering and exiting demands in the
segment. For example, an origin adjustment factor of 1.10 increases the demand of mainline or an
on-ramp segment by 10%. Similarly, a destination adjustment factor of 0.85 will reduce the demand
at an off-ramp by 15%. For weaving segments, the entering and exiting demands can be changed
with the applicable origin and destination adjustment factors, respectively.
The origin/destination demand adjustment factors are intended to run quick sensitivity analyses or
what-if analyses of demand scenarios. For example, they can be used to quickly assess the impact
of ITS treatments that cause a proportion of drivers to leave the freeway at an off-ramp upstream
of a freeway bottleneck. Similarly, they could be used to model a surge in on-ramp traffic. The
analyst can change all origin and destination demand adjustment factors by the same value to
model general background traffic growth (e.g. 1.05 for 5% traffic growth). For situations such as
these, the “Fill Data” tool can be used to quickly and easily change an adjustment factor for groups
of segments, multiple time periods, or the whole facility and/or study period.
CAPACITY ADJUSTMENT FACTORS
The capacity adjustment factors (CAF) are used to decrease the capacity of a segment in one or
more time intervals. The HCM capacity value for the segment in the selected time interval is
multiplied by the CAF. As a result, the speed-flow relationship of the segment is changed as is
discussed in more detail in Chapters 10 and 25. Capacity adjustment factors can be used to model
short-term incidents in a segment, to represent the effects of increased friction due to work zones,
or simply to calibrate the basic capacity for an observed, non-HCM conditions (e.g., freeway
tunnel). Capacity adjustment factors should generally only be used to reduce the per-lane
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capacity in a segment (never to increase it). The speed-flow and capacity relationships in Chapters
10 and 12–14 have been calibrated and an adjustment to higher capacities (e.g. greater than
2,400 veh/h/ln) is not recommended by the data.
The effect of advanced traffic management strategies, such as temporary shoulder use, should
be modeled by adding a lane in the appropriate segments and time intervals, and then reducing
the capacity of the revised segment using a capacity adjustment factor (since the use of a
shoulder is unlikely to result in a full lane of added capacity). For example, if the use of the shoulder
on a 3-lane, 70 mi/h basic freeway segment (per-lane capacity of 2,400 veh/h/ln) results in an
additional half-lane of capacity (1,200 veh/h/ln), it should be modeled as a four-lane segment with
a capacity adjustment factor of 0.875 (=[3 × 2,400 + 1,200] / [4 × 2,400]).
SPEED ADJUSTMENT FACTORS
The free-flow speed adjustment factors (SAF) are used to decrease the free-flow speed of a
segment in one or more time intervals. The HCM free flow speed value for the segment in the
selected time interval is multiplied by the SAF to arrive at the adjusted free-flow speed. SAFs may
be used to model free-flow speed reducing impacts of weather or incident conditions on the
freeway facility, or even onlooker impacts for events in the opposing direction.
It is emphasized that any delay calculations in FREEVAL-NC are performed relative to the original,
unadjusted free-flow speed. As such, the SAF should be used to model speed-reducing impacts of
different scenarios and NOT to calibrate the base free-flow speed for a segment. In a calibration
exercise, the analyst should therefore match the base free-flow speed to the field-observed or
predicted FFS in the segment or on the facility. The SAF is then used to adjust that base FFS for
effects such as rain, snow, etc.
DRIVER POPULATION ADJUSTMENT FACTORS
The base traffic stream characteristics for freeway segments are representative of traffic streams
composed primarily of commuters or drivers who are familiar with the facility. With the addition of
a unified speed flow equation in Chapter 12, Basic Freeway and Multilane Highway Segments, and
the ability to adjust both the base FFS and capacity in all freeway segment chapters (12–14) in
order to account for incidents and weather events, the driver population factor is no longer used.
Instead, FFS and capacity adjustment factors, SAFpop and CAFpop, are applied in combination with
other applicable SAFs and CAFs. The default value for SAFpop and CAFpop is always 1.0.

COMPARISON BETWEEN TWO FACILITIES
Since FREEVAL-NC has the ability to have multiple projects open in the same instance of the
program, it also has the ability to quickly compare multiple facilities. Facilities from different projects
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can be added to the Compare tab where they can be analyzed via a selected group of
performance measures. A facility can be added to the compare tab by right-clicking on the seed
name in the Project Navigator and selecting the “Add Seed to Compare” option. Figure 29 shows
an example where two scenarios have been added to the Compare tab.

Figure 29: Example Comparison Output.

INTERPRETING RESULTS
This section discusses the interpretation of results for an oversaturated freeway facility. A freeway
facility is defined as oversaturated, if any segment experiences a d/c ratio greater than 1.0 during
any analysis time interval. If this is the case, the user should first ensure that whatever queues have
formed during the analysis have dissipated by the end of the last time interval and that all vehicles
were able to clear the facility. To check for this, the total vehicle-miles-traveled (VMT) based on
demand flow (VMTD) should exactly match the actual VMT processed (VMTV) in the Results
Summary worksheet. If these two numbers match (within a rounding margin of error), then all
vehicles have cleared during the study period. If not, the analysis violates the underlying
assumptions of Chapter 10, which requires that all queues should be fully contained within the time-
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space domain. If VMT-Demand does not equal VMT-Volume, this assumption is violated in the timedimension.
In the event that queuing exceeds either the spatial or temporal boundaries of the facility, the
analyst should add additional segments and/or time intervals as appropriate before continuing
the analysis. An alternative in the case of space-dimension violation is to artificially increase the
length of the first upstream segment until the spillover queue is captured within the facility confines.
A congested boundary of the time-space domain means that vehicles either remain on the facility
by the end of the analysis, or in the case of extended queuing upstream of the first segment, that
the impact is not accounted for in the delay and travel times computed for the facility. Only if all
boundaries of the time-space domain are free of queuing, can it be assured that FREEVAL-NC
represents the true extent of congestion. The oversaturated facility shown in Figure 18 was
generated by applying across-the-board origin/destination demand adjustment factors of 1.11 to
all segments and time intervals for the facility that appears in some of the above examples. This
represents an 11% overall growth in traffic flow.

Figure 30: Segment and Facility Summary Output for an Oversaturated Facility.

The summary output in Figure 18 gives insight on congestion patterns and severity. In the example,
a total of 11 segments are shown to have a maximum d/c ratio greater than 1.0 (segments 8, 9,
10, and 11).
More insight can be obtained by looking at the detailed output interval 3 (the time interval with
queuing), shown in Figure 31. The exhibit shows that the d/c ratio in segment 8 is 1.10 and, as a
result, a queue starts forming in segment 7. Within the 15-min time interval, the queue fills up all of
segments 7 and 6, and extends 3,790 ft into segment 5. Queuing also occurs on the on-ramp at
segment 6, with 17 vehicles being queued on the ramp. The queuing occurs because the
calculated capacity of segment 8 (6,748 veh/h) is less than the demand of 7,398 veh/h. The actual
segment volume and throughput to the next segment (segment 9) is limited to the capacity and
thus also equals 6,748 veh/h. It is important to note that FREEVAL-NC always places the bottleneck
at the upstream end of the segment.
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Figure 31: Oversaturated output for Time Interval 3.

In the same time interval, it is evident that segments 9–11 also have d/c ratios greater than 1.0, but
no queuing occurs since the demand is metered by segment 8. This occurs because the capacity
of segment 8 is greater than or equal to the capacities of these downstream segments. For
example, the demand in segment 11 is 6,899 veh/h, which is greater than the segment capacity
of 6,748 veh/h (d/c = 1.02). However, due to the upstream (more severe) bottleneck, the volume
served in segment 11 during this time interval is only 5,859 veh/h and the served volume-tocapacity ratio is only 0.87. The bottleneck in segment 11 is therefore inactive or hidden. As a result,
the downstream segments operate at capacity, which is defined as density-based LOS E. The fact
that these segments do have d/c ratios greater than 1.0 is reflected in the demand-based LOS,
which is LOS F for segments 9 through 11. This recognizes that the segment would fail if the upstream
bottleneck did not exist (or was alleviated through geometric changes to the facility at that
location only).
The results for time interval 3 in Figure 31 show that not all the forecasted demand actually reaches
segment 9–11, due to congestion in segment 8. Because some vehicles were not served in time
interval 3, they are now added as residual demand in time interval 4. Figure 32 shows this effect.
While the segment 9–11 served volumes were lower than the demand in time interval 3, the
volumes are greater than the demand in time interval 4. For example, segment 11 demand is 5,500
veh/h, but as the upstream queue clears, the actual served volume is 5,934 veh/h in this time
interval. The output further shows that due to a drop in demand from time intervals 3 to 4, the
queues have cleared in segment 5 and part of segment 6, but still remains for segment 7 at the
end of the 15-min interval.

45

FREEVAL-NC
User Guide

July 2019

Figure 32: Oversaturated Output for Time Interval 4.

The effects of congestion are also evident in the graphical output provided as part of FREEVAL.
The graphs in Figure 33 are the same as already introduced in Figure 32, but now show the effect
of congestion. Most importantly, while the under-saturated d/c and v/c graphs in Figure 32 were
identical, the oversaturated v/c graph limits the throughput of the active bottleneck in segment 8
to 1.0. It further shows the metering effect in segments 9 through 11. The speed graph shows a
significant drop in speed as a result of the active bottleneck, but further shows that operating
conditions downstream of segment 8 are acceptable. This point is critical, since an individual
segment analysis of segments 9–11 would have predicted a much lower and congested speed.
The density plot further shows areas of queuing with densities exceeding 45 veh/mi/ln in the queued
segments.
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Figure 33: Graphical Output for Oversaturated Scenario. From Top to Bottom: Speed, Total Density (veh/mi/ln), D/C, and
Queue %.

The LOS summary table for the oversaturated scenario now clearly shows the distinction between
the density-based LOS that uses the actual volumes served on the facility and the demand-based
LOS table that shows the presence of all segments with d/c ratios greater than 1.0, including all
active and hidden bottlenecks (Figure 34).

Figure 34: LOS Summary Contours for the Oversaturated Scenario. The Top Contour is Demand Based LOS, and the Bottom
Contour is Density Based.

The density-based LOS table in Figure 34 shows that segments 6 and 7 operate at LOS F in time
intervals 3 and 4. In this case, Segment 8 is the active bottleneck and because FREEVAL-NC places
the bottleneck at the beginning of the segment, it operates at capacity, or LOS E. Since all
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downstream segments have capacities less than or equal to that of the active bottleneck, they
also operate at LOS E. The bottom portion of Figure 34 shows the demand-based LOS, which
emphasizes that segments 8–11 all have d/c ratios greater than 1.0 in time interval 3. The
comparison between the density-based and demand-based LOS tables allows a quick and easy
analysis of which bottlenecks are active and which segments are inactive or hidden bottlenecks
due to an upstream metering effect of traffic demand. The overall facility LOS is F in time interval
3, since one or more individual segments have d/c ratios greater than 1.0.

MANAGED LANES
FREEVAL-NC allows for the incorporation of managed lanes (ML) analysis alongside a freeway
facility. Managed lanes can be added to any facility by using the “Turn On” button in the Project
Toolbox as shown in Figure 35. If managed lanes already exist in the facility, the button will have
the label “Turn Off,” and can be used to remove the managed lanes from the analysis. Since
turning on or off managed lanes will change the geometry of the core facility, doing so will remove
any reliability or ATDM analysis that currently exists in the project.

Figure 35: Turning on Managed Lanes analysis via the Project Toolbox.

Once managed lanes have been added to the facility, an auxiliary lane will appear on the facility
graphic as seen in the Figure 36.
Just as with General Purpose (GP) segments, inputs regarding individual segment geometry and
volumes appear in the individual time-period segment input/output (I/O) table. To access the
managed lanes portion of the table, the analyst must select the “ML Only” or “GP & ML” option in
the Table Display Panel in the top left corner of the Single Seed/Scenario I/O panel (highlighted by
a red box in Figure 36).
Most of the segment inputs for managed lanes are essentially analogous to those for general
purpose segments. Keeping with the style of the general purpose segment I/O table, a green row
name indicates the input parameter is time-independent (i.e. segment type and segment length),
and an orange row name indicates that the parameter can vary for each analysis period (i.e.
mainline and ramp demands). The user must enter the demand flows for each managed lane
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mainline segment and ramp in every time interval. If a parameter is not applicable to a given
segment, then the table cell will not be editable and will have a dark gray background.
The coding of segment types and other segment input parameters for managed lanes is done in
the exact same way as for general purpose segments. Values are entered in the segment I/O
table, and once the parameters for every segment have been entered, the analyst moves to the
next analysis period using the control buttons until all inputs have been completed. The “Fill Data”
tool can also be used for managed lane segments, and managed lanes inputs can be accessed
by choosing “Managed Lanes Segments” at the top of the “Fill Data” window (see Figure 18). For
more information on managed lanes inputs and analysis, see Chapters 10, 12, 13, and 14 in the
HCM.

Figure 36: Facility with managed lanes analysis.
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GENERATE PDF REPORTS
FREEVAL-NC is capable of generating PDF reports containing inputs and outputs of the analysis.
There are three PDF reports templates that are designed for different types of analysis. There is one
template for a single study period analysis, which can be generated when a single study period
analysis is done. The dialogue generates the PDF report can be opened by clicking on the “SingleDay” button on top-right section of the main window of FREEVAL-NC (Figure 37).

Figure 37: FREEVAL-NC “Single Study Period” PDF generator configuration dialogue.

Appendix A contains a sample PDF report for a single study period analysis.

SINGLE STUDY PERIOD SCENARIO EVALUATION
FREEVAL-NC enables the user to create scenario with either work zone, severe weather condition,
or an incident, and compare with the base case (raw seed file), or other scenarios. At the end, the
user can generate a PDF report for each of these scenario assessments. In order to create a
scenario, the user must click on the “Create/Edit” button in the “Scenario Analysis” frame. This will
invoke the main scenario management screen in FREEVAL-NC. Figure 38 shows the scenario
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management screen in FREEVAL-NC. By pressing the “Create Scenario” button on the center of
the screen, an empty scenario will be created.

Figure 38: Scenario management wizard in FREEVAL-NC

WORK ZONE SCENARIO EVALUATION
In order to model a work zone on a scenario that has been created, the user must stay (or move)
to the “Work Zone Configuration” tab (Figure 39).
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Figure 39: Work zone configuration wizard in FREEVAL-NC.

The user must click “Add” button and enter the configuration of the work zone that need to be
modeled. As seen in Figure 40, a single lane closure work zone is modeled on segments 16, 17 and
18 for the entire day.
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Figure 40: Example work zone configuration in FREEVAL-NC.

The user can review the summary tab in this screen and get some idea on the impact of the work
zone on the key freeway performance measures. By default, “travel time” is selected (Figure 41).
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Figure 41: Quick summary and assessment of the work zone.

By clicking on the “Return to FREEVAL” button, the user can save the work zone configuration
information and return to FREEVAL-NC’s main window. Then, by selecting the work zone scenario
on the tree representation of the project, the user can view the analysis containing the work zone.
Majority of the times, the user goes to “Compare” tab, and adds the seed file and the work zone
scenarios to the “compare”, which provides a high-level overview of the impact of the work zone
on the key freeway performance measures. A facility can be added to the compare tab by rightclicking on the seed name in the Project Navigator and selecting the “Add Seed to Compare”
option. As shown in Figure 42, the work zone will increase the user delay cost to $152K.
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Figure 42: Work zone impact example

Appendix B contains a sample PDF report for a work zone scenario analysis.

INCIDENT OR SEVERE WEATHER SCENARIO EVALUATION

In FREEVAL-NC, the user can evaluate the impact of an incident or a severe weather condition.
Similar to the work zone scenario, the user must create a scenario first. Then by moving to the “nonrecurring Congestion Event” tab, he/she can model an incident or a severe weather condition.
Figure 43 shows an example where a “medium rain” even is modeled from 6am to 9am, and an
incident occurs at 5pm that closes a lane for an hour on segment #6. Similar to the work zone
scenario, the user can overview the impact by going to the “Summary & Comparisons” tab.
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Figure 43: Incident and weather event example

RELIABILITY ANALYSIS
Before conducting reliability analysis in FREEVAL-NC, it is recommended to store a master copy of
the core facility file in a separate folder for use in future projects and analyses. It is possible that
making certain changes to the inputs during the reliability analysis will result in the loss of earlier
data entries, and there is no option to “undo” changes in the engine. Therefore, it is recommended
to back up the files generated by a core facility analysis in a separate folder to avoid any
unwanted overwriting or loss of data.

RELIABILITY SCENARIO GENERATION OVERVIEW
The Freeway Scenario Generation (FSG) approach generates scenarios in a manner such that the
characteristics of the impacting factors on travel time within scenarios best match real-world
conditions. For example, the distribution of the number of incidents in various scenarios will have a
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similar distribution to the number of incidents observed in the field. This is achieved by assigning
appropriate traffic demand levels, weather events, work zones and incidents within the different
scenarios. Thus, each scenario generated represents a study period uniquely characterized by a
set of Capacity, Demand, Speed, and Number of Lanes Adjustment Factors for each segment and
each analysis period and is given a probability representing its likelihood of occurrence.
Based on SHRP2-L08 findings (Zegeer, et al., 2014), eight distributions are entered into the scenario
generation procedure:
•
•
•
•
•
•
•
•

Temporal Distribution of Traffic Demand Level
Temporal Distribution of Weather Event Frequency
Distribution of Average Weather Event Duration by Weather Event Type
Temporal Distribution of Incident Event Frequency
Distribution of Incident Severity
Distribution of Incident Duration given Severity
Distribution of Incident Event Start Time
Spatial Distribution of Incident Event

As detailed in the subsequent sections, the user will be required to provide some of these
distributions as reliability inputs, and those that are not required as inputs will be handled internally
by the FREEVAL-NC engine.

IMPORTANT DEFINITIONS
Before discussing the scenario generation process in more detail, it is first important to define the
following terms.
•
•
•
•

Demand Combination – A combination of a specific weekday and a month of the year.
Sometimes referred to as a demand pattern.
Reliability Reporting Period – The length of time for which the travel time distribution will be
generated (typically one year).
Analysis Period – 15 minute increment analyzed in HCM Freeway Facilities methodology
Study Period – Time frame within a given day on which the reliability analysis is performed,
could extend up to 24 hrs.

SCENARIO GENERATOR LAYOUT
This section provides step-by-step guidance for the use of the Reliability Analysis tool. There are five
major steps to run the scenario generation tool:
1) Global Reliability Properties
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Demand Multiplier Information
Work Zone Activity and Adjustment Factors
Incident Frequency and Adjustment Factors
Weather Frequency and Adjustment Factors

For ease of navigation, the scenario generation dialog is divided into five tabs with each one
represented one of the above steps. It is generally recommended that the analyst address the
inputs in order from Step 1 to Step 5 (or from left to right in the tabbed panel layout). However, the
engine is designed to be flexible enough so that the user can move freely between all steps at any
point during the analysis with no unwanted consequences. For example, if the user is in the process
of defining the weather event frequencies, he or she can freely move back to the demand tab to
adjust the demand multipliers of Step 2, if it is for any reason necessary, and can then return directly
to Step 5.
As a note, all steps described subsequently only refer to inputs for general purpose (GP) segments
and thus drop the label. Reliability Analysis with Managed Lanes segments is addressed later in
Section Error! Reference source not found..

Step 1

Step 2

Step 3

Step 4

Step 5

STEP 1: ENTER THE GLOBAL RELIABILITY PARAMETERS
In Step 1, each reliability analysis has a number of global properties that must be specified. The
Properties tab is divided into 4 subsections: general properties, event type inclusion, random
number generator options, and the number of demand combination realizations. Figure 44 shows
an example of the global inputs for Step 1.
First, the user should specify the “Seed Date” and “Reliability Reporting Period” (RRP). The “Seed
Date” represents the date for which the underlying facility has been coded and will serve to adjust
the demand multipliers of Step 2 accordingly. The RRP is the length of time for which the travel time
distribution is generated. While an RRP is typically one year, FREEVAL-NC allows it to range from as
small as a single day to as large as a full year. Since changing the RRP will affect which parameters
need to be entered in subsequent steps, the user is asked to confirm any changes that are made
by using the “Set RRP Period” button. To remind users of this, a red notification will appear in the
panel, if the RRP has been altered but not set.

58

FREEVAL-NC
User Guide

July 2019

Figure 44: Global Reliability Analysis Properties Panel for Step 1.

Next, the user should choose which types of non-recurring congestion events (i.e. work zones,
incidents, and weather) will be included in the analysis. Checking or unchecking the inclusion of
an event type will show/hide the respective panel accordingly. By default, all event types are
enabled for each reliability analysis. Ignoring the random number generator seed options of the
third section for a moment, the last subsection allows the user to define the number of Demand
Combination (DC) realizations. The default for this value is 4 since each DC occurs around 4 times
in a given month/year. However, the value can be increased or decreased to adjust the resolution
of the analysis, and guidance for the recommended number of realizations as a function of the
length of the reliability reporting period is provided in Chapter 11 of the HCM. As a warning,
increasing the number of DC realizations can lead to large amounts of scenarios and slower
running times for the reliability analysis.
RANDOM NUMBER GENERATOR SEED OPTIONS
The third subsection of the properties panel can be of particular importance for reliability analysis.
The scenario generation procedure uses a random number generator (RNG) to assign randomlygenerated non-recurring congestion events to the generated scenarios. The RNG can be
“seeded” by a number in order to control the process of how the random values are generated.
In other words, two RNGs with the same “seed” number will generate the same sequence of
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random numbers. The user is given three options for “seeding” the RNG. First, each analysis can use
a new RNG “seed” based on the time the analysis is being created. Second, the user can specify
a “seed” of their own choosing. Lastly, since the RNG “seed” for each analysis is stored in the
project file, the “seed” used for the previous Reliability Analysis run can be used – provided a
previous run has been made. While in most cases, the user will not be concerned with the RNG
“seed” value, it can be useful to recreate or repeat previous reliability analysis. Further, the
generation procedure is designed so that each event type is generated independently, which
allows for events of a single type to be generated in the same way regardless of whether or not
another type of event is included in the analysis. For example, if a Reliability Analysis with both
incidents and weather is run with the RNG “seed” 1234, a second analysis with the same RNG
“seed” can be run with just incidents to determine what effect the weather had on the travel time
distribution.

Step 1

Step 2

Step 3

Step 4

Step 5

STEP 2: DEMAND INFORMATION
The overall demand input for general purpose segments is found in the Demand panel. In this step,
the user can assign demand adjustments (herein called multipliers) for the facility in the table
provided in this panel. A demand multiplier can be assigned for each demand combination that
exists in the RRP specified in Step 1. The user can configure the daily and monthly demand
adjustment factors (DAF) based on the daily and monthly variability of traffic demand for the
subject facility or by using national defaults. All adjustments in this table are based on the ratio of
the cell value to the AADT for the facility being analyzed. If such values do not exist locally, then
the user can select tabulated national default values for either urban or rural freeway facilities.
The left side of the panel contains a list of each day of the week next to a checkbox. This allows
the analyst to choose which days of the week occurring in the RRP will be included in the scenario
generation process. In Figure 45, note that only the weekdays are enabled for the analysis.
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Figure 45: Demand Information Panel for Step 2 of a Reliability Analysis.

The section at the bottom of the panel allows the user to exclude specific days (holidays, special
event days, etc.) from the analysis. The two drop down selection boxes specify the month and day
to be excluded (assumed to be in the same year as the RRP specified in Step 1). Once the user has
selected the date, pressing the “Add” button will add the date to the list of dates excluded. The
user can select any date in the list and remove it using the “Remove” button or use the “Remove
All” button to clear all dates from the exclusion list. Figure 45 shows that both December 24th and
December 25th are being excluded from the analysis due to abnormal traffic on these days.
If no set of demand multipliers has been coded previously, then the table at the center of the
panel will be filled with a value of 1.0 for each Demand Combination. The example panel in Figure
45 shows the national “Urban Default Values” coded in the table. It is emphasized here that the
national default values may not be appropriate for use for the subject facility. Research in SHRP2L08 and testing through SHRP2-L38 has suggested that the default values rarely match the facilityspecific demand adjustment factors. The factors are maintained in the engine for facilities where
no annual demand data are available. But as a general recommendation, the analyst is strongly
encouraged to develop facility-specific demand adjustments instead of relying on these defaults.
In the implementation of the method, the demand for each scenario is adjusted from the seed file
values. This process is best explained using a numerical illustration. Say the user coded traffic
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demands in the seed file that represent a Wednesday in August. Based on Figure 45, a Wednesday
in August has a demand multiplier equal to 1.053. This means that the seed file demands are 5.3%
higher than the AADT. To generate demand volumes for say Fridays in June, for which the multiplier
is defined as 1.199, the demand volumes for each analysis period in the seed file are multiplied by
the ratio 1.199/1.053 or 1.139. It goes without saying that for demand combinations with multipliers
that are below 1.053 (e.g., Mondays or Wednesdays in December in Figure 45), the resulting ratio
would be less than 1.0.

Step 1

Step 2

Step 3

Step 4

Step 5

STEP 3: WORK ZONE EVENTS
FREEVAL-NC gives the user the ability to schedule work zones that may occur in all or part of the
RRP for a reliability analysis. In the scenario generator process, work zones are treated as nonrecurring sources of congestion whose occurrences are scheduled by the analyst. Work zones can
be added to any analysis using the GP-Work Zones panel.
For each work zone, the analyst must specify eight things, consistent with the HCM work zone
procedure described in Chapter 10:
1)
2)
3)
4)
5)
6)
7)
8)

the start and end dates of the work zone during the RRP;
a continuous subset of segments on which the work zone is active;
the analysis periods during the study period for which the work zone is active;
the severity of the work zone (shoulder closure, 1 lane closure, etc.);
the area type of the work zone (urban vs rural);
the barrier type of the work zone separation;
the work zone speed limit; and
the lateral distance.

Once all of the above inputs have been entered, the user can add the work zone to the list using
the “Add” button. The “Remove” and “Remove All” buttons can be used to edit the list of existing
work zones.
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Figure 46: Work Zone Specification Panel for Step 3.

Figure 46 shows a work zone that has been scheduled by the user for the entire month of April. The
work zone is active in segment 15 for the entirety of the study period. The “Work Zone Adjustment
Factors” section at the bottom of the table shows the adjustment factors available for the active
segments of the work zone (only segment 15 in this case).

Step 1

Step 2

Step 3

Step 4

Step 5

STEP 4: INCIDENT EVENTS
In Step 4, the analyst characterizes incident events in terms of probability of occurrence, duration,
and severity on the freeway facility. The GP - Incidents tab panel is divided into three main sections.
The first section (top left) contains the frequencies of incident occurrence for each month of the
RRP. This section allows these values to either be entered as facility specific values by the analyst
or generated using one of three automatic methods. The latter option pertains to those cases when
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incident logs are not available or are of insufficient quality to fully enable direct calculation and
entry of incident probabilities.
Conceptually, both options result in a table of incident probabilities by incident type and month
of the year. But while the first option requires a “data rich” environment with detailed records of
incidents, the frequency generation tools are available for any facility, including ones with no
incident data at all. The frequency generation tools will be explained more in depth in the following
sections.

Figure 47: Incident Inputs for Step 4.

The second subsection (top right) of the tab panel allows the user to specify both the distribution
of incident types and their durations. The distribution of different incident types along with their
mean duration and standard deviation are entered as shown in the top right table of Figure 47.
Note that the sum of the percentages should add up to 100%, and scenario generation cannot
proceed if this condition does not hold. If the distribution of incident types is not available, the user
can select national default values by pressing the “Use National Default Data” button. If any
distribution has been entered for a previous reliability analysis on the project, the “Use Saved Seed
File Distribution” will pull those values from the project file. Figure 48 shows a close-up of this section.
For each incident type, the user can enter the mean duration and standard deviation, as well as
the minimum and maximum duration. These values will be used to generate durations for incidents
of each type occurring on the facility. A set of default durations are provided and can be
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accessed through the “Use Default Durations” button. Also, as with the incident probability
distribution, if duration information has been entered for a previous reliability analysis performed on
the project, it can be accessed using the “Use Save Seed File Durations Button.” See Figure 48 for
a more detailed look at the duration input table and default options.

Figure 48: Close-up of the Incident Type Distribution and Duration Parameters Section.

The final subsection of the tab panel (bottom of Figure 47) contains four tables that allow the
analyst to enter custom adjustment factor parameters for each incident type. In the top left table,
the analyst can enter incident-specific Capacity Adjustment Factors (CAF) per open lane of the
freeway. This entry should be determined for different incident types and is based on the number
of lanes available on the facility. A more detailed view of the capacity adjustment factor table is
shown in Figure 49. A note of caution: CAFs provided in HCM and FREEVAL-NC are capacity
adjustments for remaining open lanes, and they do not account for capacity loss due to the lanes
that are closed. Any loss of lanes is accounted for as a separate input.

Figure 49: Close-up of the Capacity Adjustment Factors Table in the GP-Incidents Panel.

Users should also enter the Speed Adjustment Factors (SAF) in the top right table, and the expected
Demand Adjustment Factors (DAF) based on local conditions in the bottom left table. There are
no national default values for either parameter at this time. The final table in the bottom right of
the subsection shows the Lane Adjustment Factors (LAF) for each incident type on a per number
of open lanes basis. This table cannot be edited and is just shown for reference.
In the CAF, SAF, DAF, and LAF tables all unnecessary cells are blacked out, and the user only needs
to provide (optional) information for cells with a white or blue background.
FREQUENCY GENERATION WITH INCIDENT OR CRASH RATES
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If the analyst has little or no incident data available, there are three different paths available to
estimate incident probabilities. These frequency generation tools can be accessed by clicking on
the “Calculate Frequencies” button in the first subsection of the GP – Incidents tab panel of the
scenario generator (see Figure 47).
The first path is to determine if incident rates (per 100 million VMT) are available for the facility. If so,
then those can be entered on a monthly basis. Allowance is made to enable the user to vary
incident rates per month, if such information is available.
If not, the second path is to use monthly crash rates for the facility, which are easier to collect and
can be used in conjunction with an estimated local incident to crash ratio to estimate monthly
incident rates. A default factor for the ratio of incidents to crash rates is provided but can be
overridden by the user.
Once the required values have been entered for either of the two paths, the incident frequencies
can be generated by pressing the “Calculate Frequencies Using Incident (Crash) Rates” button.
Figure 50 shows the “Incident Frequency Calculator” and the inputs required for the first two paths.

Figure 50: Frequency Generator Inputs Using Incident or Crash Rates.

FREQUENCY GENERATION WITH THE HERS MODEL
If neither crash nor incident rate data are available, then a third path is to generate crash rates
using the HERS model (Dowling Associates, Inc; Cambridge Systematics, Inc, 2011). This option is

66

FREEVAL-NC
User Guide

July 2019

invoked by selecting the “HERS Model” at the top of the Incident Frequency Calculator as shown
in Figure 51. If the HERS model is used to generate the crash rates, the user must provide input on
the portion of the AADT which occurs in the typical study period. This is readily performed from a
known distribution of hourly factors. Additionally, the user must provide a ratio of crash rate to
incident rate. With these two inputs, a set of monthly crash rates can be calculated by pressing the
“Calculate Crash Rate Based on HERS Model” button. Finally, the incident frequencies can be
generated by pressing the “Calculate Frequencies Using the HERS Model” button.

Figure 51: Frequency Generator Inputs Using the HERS Model.

Step 1

Step 2

Step 3

Step 4

Step 5

STEP 5: WEATHER
The inputs for Step 5 are designed to capture all necessary weather information for the generation
of scenarios that include weather events and their impacts. There are two main subsections of the
Weather tab panel of the scenario generator. The first allows the analyst to enter the probabilities
of occurrence of ten weather event types for the months included in the RRP, and the second
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allows the analyst to enter duration and adjustment factor parameters for each of the weather
categories. Figure 52 depicts a sample weather worksheet screenshot with data shown for Albany,
NY.

Figure 52: Weather inputs for Step 5.

The first subsection (top of the panel) consists of a single table, where the analyst can enter
temporal probabilities for the occurrence of each weather event type in each month included in
the RRP. Each cell represents the ratio of the number of hours in which a weather event occurred,
divided by the number of hours in the study periods falling in each month. For example, the 5.6%
value highlighted in Figure 52 (light snow in March) represents the ratio (%) of hours in the 2-8pm
study period in which light snow occurred in March in Albany to the total number of hours in March
between 2-8 pm. These estimates are based on 10 years of meteorological historical data
extracted from 96 metropolitan areas in the US. The user can directly extract the probabilities by
choosing “Albany, NY” in the drop down menu for selecting the nearest metro at the top of the
panel in Figure 52 and then pressing “Extract Longterm Regional Weather Data.” The user can, of
course, override any cell values and directly enter facility specific weather probabilities when those
are available. The user can clear all values in the table by selecting “New Facility Specific” in the
metro area drop down list and clicking the “Extract” button.
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The bottom table documents the key operational impacts of each weather category in the form
of weather duration, as well as, capacity, speed, and demand adjustment factors. The first row
pertains to the mean duration of each weather type with respect to the location of the facility. If
the scenario generator weather database had been selected to fill the top table (for the nearest
metropolitan area) then the mean duration for the selected metropolitan area will be
automatically filled in the first row.
The second and third rows in the bottom table require weather event inputs for the Capacity
Adjustment Factor (CAF) and Free Flow Speed Adjustment Factor (SAF), respectively. These factors
are used in scenario generator of FREEVAL-NC to model weather event impacts on facility
operations. The CAF and SAF tables are currently filled with national default values in the HCM, but
can be overridden by the analyst when local data is available. The last row in the bottom table
enables the specification of the Demand Adjustment Factor (DAF) for each weather category.
There are no default values here, but local conditions may provide guidance as to the level of
demand adjustments associated with the more severe weather conditions. For example, the
analyst may code a demand adjustment factor of less than 1.0 for a heavy snow event to reflect
the fact that many drivers may avoid travel during those severe weather conditions.
Similar to some of the previous steps, if an existing set of inputs has been entered for a previously
conducted reliability analysis, these values can be extracted from the project file by pressing the
“Use Values Stored in Seed” button (see the top of Figure 52). Lastly, if the analyst enters a new set
of facility specific values, he or she can choose to export them to a database file (saved in a
specific .csv format) and import them into a reliability analysis at a later time. These actions can be
performed using the “Export” and “Import” buttons at the top of the panel shown in Figure 52.

GENERATING THE SCENARIOS
Once the inputs for Steps 1-5 have been specified, FREEVAL-NC is ready to generate the set of
reliability scenarios. The number of scenarios generated depends on the length of the RRP, the
number of Demand Combinations (month/day of week combinations), and the number of
realizations of each demand combination. For a full year RRP of just weekdays (Monday-Friday)
with 4 realizations, the total number of scenarios is 12 (months) x 5 (weekdays) x 4 (realizations) =
240 scenarios.
The reliability scenario set can be generated in one of two ways: only generate the scenarios or
generate and run the set of scenarios. For most situations, the computational efficiency of FREEVALNC should be high enough that the second option will be the desired choice. For the
recommended settings (1 year RRP, 4 realizations), the entire process should take no more than a
few seconds. However, if the number of scenarios is exceptionally high, or the computational time
is slow for some other reason, the first option can lighten the load on the computer. If the scenarios
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are generated only and not run, the analyst can run the scenarios by pressing the “Summary”
button in the Reliability Analysis portion of the Project Toolbox at the top of the main window of
FREEVAL-NC.

SCENARIO MANAGEMENT
Once the scenarios have been generated, the main window of FREEVAL-NC will be populated
with their data as shown in Figure 53.

Figure 53: Main Window of FREEVAL-NC with a Reliability Analysis.

The Project Navigator on the left side of the window will now display the scenarios in an expanded
tree. Levels of the tree display can be collapsed or expanded by double clicking on a layer with a
folder icon or clicking on the switch next to a folder icon. Performing a reliability analysis will add a
second level “Reliability Scenarios” folder to the tree beyond the project folder and core facility
seed file. The folder title will indicate the number of reliability scenarios in parentheses. When the
folder is expanded, the scenarios will display in order from the first demand combination of an RRP
(i.e. Monday in January) to the last demand combination (i.e. Friday in December).
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The name of each reliability scenario contains the index of the scenario, the abbreviated demand
combination it represents, the demand multiplier, and the number of events of each type
occurring in the scenario. For example, for Scenario #21 in Figure 53 the demand combination is
“Feb-Mon” with a demand multiplier of 0.853, and the scenario contains one weather event and
one incident (IGP refers to incidents in a GP segment, while IML refers to incidents in an ML
segment). Extended information about a particular scenario can be viewed by simply hovering the
mouse pointer over the scenario in the Project Navigator. Figure 54 shows this for Scenario #21,
where the popup also includes the scenario probability of 0.38%, the type of weather event as
medium-heavy snow starting in period 16 with a duration of two periods, and the incident as a
shoulder closure at segment 32 starting in period 2 for two periods.

Figure 54: Extended scenario information viewed from the Project Navigator.

Each seed facility can contain one reliability analysis set. To delete an analysis and return to just
having the core seed facility, the user can use the “Delete” button in the reliability analysis portion
of the Project Toolbox at the top of the main FREEVAL-NC window. Additionally, if the user wishes
to run a new reliability analysis, he or she can simply return to the scenario generator, and any new
set of scenarios that is created will automatically replace the current set. If the analyst wishes to
compare two reliability analyses on the same core seed facility, the analyses will need to be
conducted in two separate files, but both projects can be opened and compared in the same
FREEVAL-NC instance.
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EVALUATING SCENARIOS AND VIEWING RESULTS

EVALUATING INDIVIDUAL SCENARIOS
Once a reliability analysis has been generated, the segment I/O table automatically switches to
output mode. The table, facility graphic, and summary panels work exactly as discussed previously
in section 0 with the only difference being that the output will show values for the scenario selected
in Project Navigator instead of the core seed facility (unless of course the seed facility is selected).
An individual scenario is selected to be the “active scenario” in the window by clicking on its name
in the Project Navigator. This allows individual scenarios to be evaluated in the exact same way as
the core seed facility. The analyst can view the inputs of each scenario by changing the segment
I/O mode back to “Input” or “In & Out.” However, it should be noted that the only inputs that will
differ between the seed facility and a scenario are the reliability adjustment factors.
As with the core seed facility, both the contour and summary panels can be used to evaluate the
individual active scenario. Individual scenarios can be added to the Compare panel in the same
manner as seed facilities – by right-clicking on the scenario name in the Project Navigator, and
selecting the “Add Scenario to Compare” option. Figure 55 shows a comparison between the seed
facility and each scenario generated for the January-Monday demand combination.
For more information on these methods of evaluating individual scenarios, see section 0.

Figure 55: Comparison Between All Scenarios for the Month of January.
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EVALUATING A RELIABILITY ANALYSIS IN ITS ENTIRETY
The user may view the summary output for a reliability analysis by pressing the “Summary” button
in the reliability portion of the Project Toolbox (see Figure 56). If the scenario set for the reliability
analysis has only been generated and not run, a batch run of all scenarios will be performed.
Depending on the size of the scenario set, the run time could range from a few seconds to a few
minutes. Once the run is complete, a summary window will appear.

Figure 56: Reliability analysis “Summary” button of the Project Toolbox.

In general, all statistics in the summary report are weighted by the vehicle-miles-traveled (VMT) of
traffic served of the respective scenarios. In other words, the estimates of travel time and other
performance measures are weighted by the amount of traffic served in each scenario. A scenario
with more demand will therefore weigh more heavily in the overall results than a low-demand
scenario.
The motivation for weighing all results by the VMT is to approximate the performance as
experienced by the traveler. For example, the VMT-weighted distribution of the travel time index
(TTI) reflects the distribution as observed by drivers, with scenarios impacting more drivers (higher
VMT) contributing more probability than low VMT-scenarios. These results are therefore different
from just calculating an arithmetic average of the TTI across all scenarios.
The summary report consists of three main sections. The top section of the panel provides a
summary of the general information for the project and reliability analysis such as the length of the
facility, the number of scenarios, and information about the RRP, etc. The section below titled
“Facility Reliability Performance Measures” contains the overall reliability statistics for the facility.
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Figure 57: Example Reliability Analysis Summary Window.

The basic performance measures contained in Figure 57 are as follows:
•
•
•

•

•

•

•
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Mean TTI: The average, VMT-weighted travel time index on the facility.
50th Percentile TTI: The median, VMT-weighted travel time index on the facility.
80th percentile TTI for the subject facility, which is also VMT-weighted. This measure has
been found to be more sensitive to operational changes than the PTI, which makes it
useful for comparison and prioritization purposes.
PTI: The Planning Time Index for the facility, which is defined as the 95th percentile of the
VMT-weighted cumulative TTI distribution. This measure is useful for estimating the amount
of extra time travelers must budget to ensure an on-time arrival and for describing nearworst-case conditions on urban facilities.
Misery Index: This measure is defined as the average of the highest 5% of the TTI
distribution divided by the free-flow facility travel time. This measure is useful as a
descriptor of near-worst-case conditions on rural facilities.
Semi-Standard Deviation: A one-sided standard deviation, with the reference point at
free-flow speed instead of the mean. It provides the variability distance from free-flow
conditions.
Reliability Rating: A reliability criterion that approximates the number of trips at a minimum
speed of 33% lower than the FFS, which approximately coincides with the speed at
capacity for freeways with a 70mph FFS.
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Percent of VMT at TTI > 2: A failure criterion that approximates the relative number of trips
with a travel time twice than the free-flow travel time, which coincides with an average
speed of half the FFS.

RELIABILITY ANALYSIS SUMMARY CHARTS
In addition to these statistics, Figure 57 contains a panel with two tabs. The first of which, the
Reliability Analysis Summary Charts tab, shows a set of two output graphs for the facility. The left
graph gives the probability density function (PDF) as a bar chart, and the right graph shows the
cumulative distribution function (CDF) of facility TTI. Both distributions are VMT-weighted.
Clicking on the “Show TTI Percentile Detail” button opens a window that gives a more in-depth look
at the TTI distribution values for each 5% percentile increment (Figure 58). Based on Figure 58, the
maximum TTI observed in this analysis is 41.29. The window also allows the user to enter a fieldobserved TTI distribution for comparison and validation of the analysis. Once this information is
entered, the user can click the “Save” button if he or she wishes to view the comparison on the
CDF chart in the summary report. For illustration purposes, a TTI distribution has been entered in
Figure 58, and Figure 59 shows the field TTI CDF on the chart.

Figure 58: Detailed view of the TTI distribution with values entered for field observed TTI. (For the sake of saving space the
window has been cut in half and shown side by side.)
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Figure 59: Reliability Analysis Summary Report with a field-observed TTI curve entered in the CDF line chart.

SCENARIO SUMMARIES TABLE
The second tab in the bottom section of the Reliability Analysis Result Summary is the Scenario
Summaries Table. This table provides a summary of each scenario in rows of nine columns,
specifying:
1)
2)
3)
4)
5)
6)
7)
8)
9)

the scenario index;
the scenario demand combination;
the scenario demand multiplier;
the number of work zones in the scenario;
the number of weather events in the scenario;
the number of incidents in the scenario;
the maximum TTI that occurs in any 15 minute interval in the scenario;
the number of congested analysis periods; and
the maximum VHD that occurs in any 15 minute interval in the scenario.

Figure 60 shows this table for a reliability analysis example. The table can be sorted (ascending or
descending) for each column value by clicking on the column header. Among other things, this
can be used to flag unusual or outlier scenarios with large TTI or VHD values. For example, a TTI of 2
corresponds to the average travel time being only half of the free-flow speed (e.g. average speed
of 35 mph for a 70mph FFS). These scenarios often occur in scenarios that have a combination of
multiple sources of congestion (i.e. high demand day with bad weather and an incident). The
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method does not include any default demand adjustment factors for these severe cases, but the
analyst may want to proceed carefully when manually adjusting the DAFs for heavy snow events,
for example, and re-running the analysis to gain more realistic results.

Figure 60: Example Scenario Summaries Table for a Reliability Analysis.

The “# congested APs” column counts the number of analysis periods within the study period of
the scenario for which the facility TTI is greater than a certain value. By default, this is set to be the
value of PTI, but the analyst can define it to be any value by right-clicking on the column and
selecting the “Set Congested TTI Cutoff Value” option in the popup menu.
Beyond the ability to sort the rows, a set of filters can also be used to display only certain scenarios
with values within specified ranges. For example, if the analyst only compares scenarios with 3 or
more incidents, he or she can filter out all scenarios with less than 3 from the table. Figure 61 shows
the filter dialog with this range entered.
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Figure 61: Filter options available for the Scenario Summaries Table.

SCENARIO EVENT SUMMARIES
A more in-depth look at the distribution of both incident events and weather for the set of reliability
scenarios is available for the analyst by clicking on the “Show Scenario Event Summary” button at
the bottom of the “Reliability Analysis Result Summary” window (Figure 57). This opens a window
with two tabs, one for incidents and one for weather.

Figure 62: Incident Event Summary Table.

The first table (Figure 62) shows an example of the Incident Event Summary tab. Each row of the
table corresponds to a different incident severity. The columns give the total number of incidents
of that facility, and the breakdown of that number per month. For example, the table in Figure 62
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shows that there were 21 two lane closures in the set of scenarios, and three of them occurred in
the month of October. The final row of the table gives the total number of incidents in the scenario
set and the total number of incidents occurring in each month.
A similar table is available for weather events in the reliability scenario set. An example of this is
shown in Figure 63. Again, each row of the table represents a weather event type, and the column
represents the total number of the type of event and the breakdown of the number of that type
of event occurring in each month. Since this table tends to contain many more zero values than
the incidents table, zeros have been replaced with dashes (-) to improve readability. As with the
incident table, the final row gives the total number of weather events in the scenario set, as well
as the total number of weather events in each month.

Figure 63: Example Weather Event Summary Table.

EXPORTING RAW RESULT DATA
In addition to this standard summary report, the user may decide to perform customized
calculations, and a separate summary output file can be generated for that purpose. To generate
this file, select the “Export Raw Result Data …” button in the Reliability Analysis Result Summary
window (highlighted in Figure 64), which will then prompt the user for a file name and save location.
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Figure 64: Reliability Analysis Result Summary window with the “Export Raw Result Data” button highlighted.

Appendix C contains a sample PDF report for a travel time reliability analysis.
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APPENDICES
APPENDIX A: EXAMPLE PDF REPORT
This appendix presents a sample PDF report generated by FREEVAL-NC PDF report generator.
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APPENDIX B: EXAMPLE WORK ZONE SCENARIO ANALYSIS PDF REPORT
This appendix presents a sample PDF report for a work zone scenario analysis generated by
FREEVAL-NC PDF report generator.
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APPENDIX C: EXAMPLE RELIABILITY ANALYSIS PDF REPORT
This appendix presents a sample PDF report for travel time reliability analysis generated by FREEVALNC PDF report generator.
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